Hands-On Radio Astronomy
Mapping the Milky Way

Cathy Horellou & Daniel Johansson
Onsala Space Observatory
Chalmers University of Technology
SE-439 92 Onsala
Sweden
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abstract</td>
<td>2</td>
</tr>
<tr>
<td>1 Welcome to the Galaxy</td>
<td>3</td>
</tr>
<tr>
<td>1.1 Where are we in the Milky Way?</td>
<td>4</td>
</tr>
<tr>
<td>1.1.1 Galactic longitude and latitude</td>
<td>4</td>
</tr>
<tr>
<td>1.1.2 Notations</td>
<td>4</td>
</tr>
<tr>
<td>1.2 Looking for hydrogen</td>
<td>5</td>
</tr>
<tr>
<td>1.3 The Doppler effect</td>
<td>6</td>
</tr>
<tr>
<td>2 The theory behind the Milky Way</td>
<td>8</td>
</tr>
<tr>
<td>2.1 Preliminary calculations</td>
<td>8</td>
</tr>
<tr>
<td>2.2 How does the gas rotate?</td>
<td>9</td>
</tr>
<tr>
<td>2.3 Where is the gas?</td>
<td>10</td>
</tr>
<tr>
<td>2.4 Estimating the mass of our Galaxy</td>
<td>12</td>
</tr>
<tr>
<td>3 Observing with Such A Lovely Small Antenna (SALSA)</td>
<td>13</td>
</tr>
<tr>
<td>3.1 SALSA-Onsala</td>
<td>13</td>
</tr>
<tr>
<td>3.2 Before the observations</td>
<td>13</td>
</tr>
<tr>
<td>3.3 How to observe with SALSA-Onsala</td>
<td>14</td>
</tr>
<tr>
<td>3.3.1 From a Unix machine</td>
<td>14</td>
</tr>
<tr>
<td>3.3.2 From a Windows machine</td>
<td>15</td>
</tr>
<tr>
<td>3.3.3 kstara: A planetarium program to control the radio telescope</td>
<td>16</td>
</tr>
<tr>
<td>4 After the observations – my first maps of the Milky Way</td>
<td>18</td>
</tr>
<tr>
<td>4.1 Software</td>
<td>18</td>
</tr>
<tr>
<td>4.2 Data processing</td>
<td>18</td>
</tr>
<tr>
<td>4.3 Data analysis</td>
<td>19</td>
</tr>
<tr>
<td>4.3.1 Rotation curve</td>
<td>19</td>
</tr>
<tr>
<td>4.3.2 Map of the Milky Way</td>
<td>20</td>
</tr>
<tr>
<td>Appendices</td>
<td>23</td>
</tr>
<tr>
<td>A Rotation curves</td>
<td>24</td>
</tr>
<tr>
<td>A.1 Solid-body rotation</td>
<td>24</td>
</tr>
<tr>
<td>A.2 Keplerian rotation: the Solar system</td>
<td>24</td>
</tr>
<tr>
<td>A.3 Differential rotation: a spiral galaxy</td>
<td>25</td>
</tr>
<tr>
<td>B Early history of 21 cm line observations</td>
<td>26</td>
</tr>
</tbody>
</table>
C The celestial sphere and astronomical coordinates
   C.1 A place on Earth ................................................... 27
   C.2 The celestial sphere .................................................. 27
       C.2.1 Equatorial coordinates ........................................ 27
       C.2.2 The Local Sidereal Time ...................................... 28
       C.2.3 How can I know whether my source is up? .................. 29

D Useful links

Bibliography

Acknowledgements
Abstract

SALSA-Onsala ("Such A Lovely Small Antenna") is a 2.3 m diameter radio telescope built at Onsala Space Observatory, Sweden, to introduce pupils, students and teachers to the marvels of radio astronomy. The sensitive receiver makes it possible to detect quickly the radio emission due to the spectral line of atomic hydrogen at a wavelength of 21 cm and to map the large-scale distribution of hydrogen in our galaxy, the Milky Way. The radio telescope can be operated remotely over the internet. In this report we first review some properties of the Milky Way, starting by describing the Galactic coordinate system and the geometry of a rotating disk. We describe how spectral measurements can be used to derive information about both the kinematics and the distribution of the gas in the Milky Way. Then we outline the observational procedure of how to use the radio telescope for real-time observations. Finally, we discuss how the data can be analyzed.
Chapter 1

Welcome to the Galaxy

Looking up on a clear, dark night, our eyes are able to discern a luminous band stretching across the sky. Observe it with a pair of binoculars or a small telescope and you will discover, like Galileo in 1609, that it is made up of a myriad of stars. This is the Milky Way: our own Galaxy, as it appears from Earth. It contains about a hundred billions of stars, and our Sun is just one of them. There are many other galaxies in the universe.

It took astronomers a long time to figure out what our Galaxy really looks like. One would like to be able to embark on a spaceship and see the Galaxy from outside. Unfortunately, traveling in and around the Galaxy is (and will always be) out of the question because of the huge distances. We are condemned to observe the Galaxy from the vicinity of the Sun. In addition, some areas of the Milky Way appear darker than others; this is because they are obscured by large amounts of interstellar dust, and we can't even see the stars that lie behind the dust clouds.

Observations of other galaxies and of our own, both with optical and radio telescopes, have helped unveil the structure of our Galaxy. Now, astronomers think that they have a good knowledge of how the stars and the gas are distributed. Our Galaxy seems to look like a thin disk of stars and gas, which are distributed in a spiral pattern.

But a new mystery has arisen: that of the so-called dark matter. Most of the mass of our Galaxy seems to be in the form of dark matter, a mysterious component that has, so far, escaped all means of identification. Its existence has been inferred only indirectly. Imagine a couple of dancers, in a dark room. The man is black, dressed in black clothes, and the woman wears a fluorescent dress. You can't see the man. But from the motion of the woman dancer, you can infer his presence: somebody must be holding onto her, otherwise, with such speed, she would simply fly away! Similarly, the stars and the gas in our Galaxy rotate too fast, compared to the amount of mass observed. There must therefore be more matter, invisible to our eyes and to the most sensitive instruments, but which, through the force of gravity, holds the stars together in our Galaxy and prevents them from flying away. The key argument in favor of the existence of dark matter comes from the measured velocities in the outer part of our Galaxy. Radio measurements of the type discussed here have played an important role in revealing the presence of dark matter in the Galaxy. But what dark matter really is remains an open question.
1.1 Where are we in the Milky Way?

1.1.1 Galactic longitude and latitude

Our star, the Sun, is located in the outer part of the Galaxy, at a distance of about \(8.5 \text{ kpc}\)^1 (about 25 000 light years^2) from the Galactic center. Most of the stars and the gas lie in a thin disk and rotate around the Galactic center. The Sun has a circular speed of about 220 km/s, and performs a full revolution around the center of the Galaxy in about 240 million years.

To describe the position of a star or a gas cloud in the Galaxy, it is convenient to use the so-called **Galactic coordinate system**, \((l, b)\), where \(l\) is the Galactic longitude and \(b\) the Galactic latitude (see Fig. 1.1 and Fig. 1.2). The Galactic coordinate system is centered on the Sun, \(b = 0\) corresponds to the Galactic plane. The direction \(b = 90^\circ\) is called the North Galactic Pole. The longitude \(l\) is measured **counterclockwise** from the direction from the Sun toward the Galactic center. The Galactic center thus has the coordinates \((l = 0, b = 0)\). There is, in fact, something very special at the Galactic center: a very large concentration of mass in the form of a black hole containing approximately three million times the mass of the Sun. Surrounding it is a brilliant source of radio waves and X-rays called Sagittarius A*.

![Galactic coordinate system](image)

**Figure 1.1:** Illustration of the Galactic coordinate system, with longitude \((l)\) and latitude \((b)\). C indicates the location of the Galactic center, S the location of the Sun.

The Galaxy has been divided into four quadrants, labeled by Roman numbers:

- **Quadrant I** \(0^\circ < l < 90^\circ\)
- **Quadrant II** \(90^\circ < l < 180^\circ\)
- **Quadrant III** \(180^\circ < l < 270^\circ\)
- **Quadrant IV** \(270^\circ < l < 360^\circ\)

Quadrants II and III contain material lying at galacto-centric radii which are always **larger** than the Solar radius (the radius of the orbit of the Sun around the Galactic center).

In Quadrant I and IV one observes mainly the inner part of our Galaxy.

1.1.2 Notations

Let us first define some notations. Some of them are illustrated in Figs. 1.3 and 2.2:

^1 1 kpc = 1 kiloparsec = \(10^5\) pc; 1 parallax-second (parsec, pc) = 3.086 \(\times 10^{16}\) m. A parsec is the distance from which the radius of Earth’s orbit subtends an angle of \(1''\) (1 arcsec).

^2 1 light year (ly) = 9.4605 \(\times 10^{15}\) m
Figure 1.2: Sketch of the spiral structure of the Galaxy. C indicates the location of the Galactic center.

The approximate locations of the main spiral arms are shown. The locations of the four quadrants are indicated.

\[ V_0 \quad \text{Sun’s velocity around the Galactic center} \]
\[ (220 \text{ km/s}) \]
\[ R_0 \quad \text{Distance of the Sun to the Galactic center} \]
\[ (8.5 \text{ kpc}) \]
\[ l \quad \text{Galactic longitude} \]
\[ V \quad \text{Velocity of a cloud of gas} \]
\[ R \quad \text{Cloud’s distance to the Galactic center} \]
\[ r \quad \text{Cloud’s distance to the Sun} \]

1.2 Looking for hydrogen

Most of the gas in the Galaxy is atomic hydrogen (H). H is the simplest atom: it has only one proton and one electron. Atomic hydrogen emits a radio line at a wavelength \( \lambda = 21 \text{ cm} \) (or a frequency \( f = c/\lambda = 1420 \text{ MHz} \), where \( c \approx 300000 \text{ km/s} \) is the speed of light). This is the signal we want to detect.

\[ \lambda = 21 \text{ cm} \Rightarrow f = c/\lambda = 1420 \text{ MHz} \] (1.1)

This spectral line is produced when the electron’s spin flips from being parallel to being antiparallel with the proton’s spin, bringing the atom to a lower energy state (see Fig. 1.4). Although this happens spontaneously only about once every ten million years for a given hydrogen atom, the enormous quantity of hydrogen in the Milky Way makes the 21 cm line detectable. The line
was predicted by the Dutch astronomer H.C. van de Hulst in 1945, who determined its frequency theoretically. The line was observed for the first time in 1951 by three groups, in the U.S.A., in the Netherlands and in Australia (see Appendix B).

1.3 The Doppler effect

By observing radio emission from hydrogen, we can also learn about the motion of the hydrogen gas clouds in our Galaxy. Indeed, it is possible to relate the observed frequency of the signal to the velocity of the emitting gas, thanks to the so-called Doppler effect.

This effect, named after the Austrian physicist Christian Johann Doppler (1803–1853), is present in our everyday life; for example if you are standing still in the street and an ambulance approaches you, it appears as if the pitch of the ambulance’s siren increases. Similarly, when the ambulance is receding, the pitch of the siren decreases. Because sound waves travel through a medium (the air), when the ambulance is approaching the waves will be ‘squeezed’ together by the forward motion. Shorter wavelengths mean higher frequency, and thus the pitch of the siren increases.

There is another mechanism we need to understand. One of the greatest scientific achievements of the 20th century was the theory of Special Relativity, presented by Albert Einstein in 1905. A postulate of the theory is that the speed of light is constant. We may use a simple example: a person stands by the road and watches a car drive towards her at a speed of 90 km/h. The driver throws a ball in the direction of the car at a speed of 200 km/h. The person standing by the road will observe the ball coming towards her at the speed of $90 + 200 = 290$ km/s. Imagine that the driver instead would put out a flashlight that emits light at the speed of light ($c$), and the person by the road would have a way of measuring the speed of the light beam coming towards her, the velocity of the beam would not be 90 km/h + $c$, but only $c$. This is because the speed of light is constant in all inertial frames, that is, in non-accelerating frames.

We must use the Doppler effect to relate frequency to velocity. A rather long derivation shows
that

\[
\frac{\Delta f}{f_0} = -\frac{v}{c}
\]  

(1.2)

where

\[
\Delta f = f - f_0 \quad \text{is the frequency shift},
\]

\[
f \quad \text{is the observed frequency}
\]

\[
f_0 \quad \text{is the rest frequency of the line we are observing}
\]

\[
v \quad \text{is the velocity; } > 0 \text{ if the object is receding, } < 0 \text{ if it is approaching.}
\]

When we want to observe the \(\lambda 21\ cm\) line of hydrogen along a Galactic longitude, we tune the receiver of our radio telescope to a frequency band near the exact frequency of the hydrogen line. This will allow us to find hydrogen gas with different velocities that emit at the frequency of 1420 MHz (the rest frequency of the radio line), although the frequency is shifted up or down when it reaches us, depending on whether the gas cloud that we observe is approaching us or receding from us.
Chapter 2

The theory behind the Milky Way

2.1 Preliminary calculations

Let us imagine that we point our radio telescope towards a gas cloud in the Galaxy. In Figs 2.1 and 2.2 we see that the actual velocity of the cloud \( V \) makes an angle with the line-of-sight. Thus, we will measure merely a projection of the cloud's velocity on the line-of-sight \( (V_{\text{los}}) \).

![Figure 2.1: The velocity of the cloud projected on the line-of-sight.](image1.png)

Figure 2.1: The velocity of the cloud projected on the line-of-sight.

![Figure 2.2: Geometry of the Galaxy.](image2.png)

Figure 2.2: Geometry of the Galaxy.
We observe the so-called radial velocity, \( V_r \), the projection of the cloud’s velocity on the line-of-sight minus the velocity of the Sun on the line-of-sight. From Fig. 2.2, we obtain:

\[
V_r = V \cos \alpha - V_0 \sin \nu.
\]  

(2.1)

In the upper triangle we see that

\[
(90 - l) + 90 + c = 180 \Rightarrow c = l.
\]

The angle \( \alpha \) that \( V \) makes with the line-of-sight can be computed from the triangle CMT, where we have

\[
a + b + 90 = 180 \Rightarrow b = 90 - a.
\]

The line CM makes a right angle with \( V \). Using the above expression for the angle \( b \) (not to be confused with the Galactic latitude) we have

\[
b + \alpha = 90 \Rightarrow \alpha = 90 - b = 90 - (90 - a) = a \Rightarrow \alpha = a.
\]

The final expression for \( V_r \) is obtained by rewriting eq. 2.1:

\[
V_r = V \cos \alpha - V_0 \sin l
\]

(2.2)

We now want to replace \( \alpha \) with other variables. Looking at the triangles CST and CMT we find that the distance between the Galactic Center (C) and the tangential point (T) can be expressed in two different ways:

\[
CT = R_0 \sin l = R \cos \alpha
\]

(2.3)

Substituting \( \cos \alpha \) from eq. (2.3) into eq. (2.2) we obtain

\[
V_r = \frac{V R_0}{R} \sin l - V_0 \sin l
\]

(2.4)

### 2.2 How does the gas rotate?

In this part of the exercise, we intend to measure the Galaxy’s rotation curve \( V(R) \) in the first Galactic quadrant.

There can be several clouds along the line of sight. One usually observes several spectral components, as illustrated on Fig. 2.3. The largest velocity component, \( V_{r,\text{max}} \), comes from the cloud at the tangential point (T), where we observe the whole velocity vector along the line-of-sight. At the tangential point, we have:

\[
\begin{cases}
R = R_0 \sin l \\
V = V_{r,\text{max}} + V_0 \sin l.
\end{cases}
\]

(2.5)

By observing at different Galactic longitudes, we can measure \( V_{r,\text{max}} \) at different values of \( l \). We can then calculate \( R \) and \( V \) for each \( l \), and plot the rotation curve \( V(R) \).

**Summary.** We have:

- observed HI at different Galactic longitudes \( l \) in the first quadrant;
- measured the maximum velocity component \( V_{r,\text{max}} \) at each \( l \);
- assumed that the corresponding gas lies at the tangential point;
- assumed that we know \( R_0 \) and \( V_0 \);
- From that, we could derive the rotation curve of the Galaxy \( V(R) \).

→ At this point, it would be a good idea to read Appendix A.
2.3 Where is the gas?

Now we would like to find out where is the HI gas that we have detected. In the previous paragraph, we had used only the maximum velocity component in the spectrum, and assumed that it came from gas at the tangential point. Now, we shall use all the velocity components that we observe in the spectrum, and

- assume a certain rotation curve \( V(R) \)

   to infer the location of the gas.

As in the previous paragraph, we shall

- measure \( V_r \) in different directions \( l \) in the Galaxy,

- assume that we know \( R_0 \) and \( V_0 \).

Again, we use equation (2.4)  But, motivated by the shape our measured rotation curve (Sect. 2.2), we assume now that the gas in our Milky Way obeys differential rotation, that is, the circular velocity is constant with radius: \( V(R) = \text{constant} = V_0 \) (Have you read Appendix A?). Equation (2.4) thus becomes:

\[
V_r = V_0 \sin \left( \frac{R_0}{R} - 1 \right)
\]

(2.6)

and we can express \( R \) as a function of known quantities:

\[
R = \frac{R_0 V_0 \sin l}{V_0 \sin l + V_r}
\]

(2.7)

Now we would like to make a map of the Milky Way and place the position of the cloud that we have detected. From our measurement of the radial velocity \( V_r \) we have just calculated the distance of the cloud to the Galactic center, \( R \), and we know in which direction we have observed (the Galactic longitude \( l \)).
Figure 2.4: Interesting geometrical properties related to the tangential points. All tangential points lie on the half-circle centered exactly between the Sun and the Galactic center. The locations of three tangential points are indicated. Parts of some circular orbits are shown to illustrate that the velocity is at a maximum there.

- If we have observed in Quadrant I or Quadrant IV, there can be two possible locations corresponding to given values of \( l \) and \( R \) (see Figure 2.2): closer to us than the tangential point \( T \) (the actual point \( M \) on the figure), or farther away, at the intersection of the ST line and the inner circle.

- If, on the other hand, we have observed in Quadrant II or Quadrant III, then the position of the emitting gas cloud can be determined uniquely.

→ You may want to make a drawing to convince yourself that this is true.

This can be shown mathematically: let us express \( SM \), the location of the cloud in polar coordinates \((r, l)\), where \( r \) is the distance from the sun, and \( l \) the Galactic longitude defined earlier. In the triangle CSM, we have the following relation:

\[
R^2 = R_0^2 + r^2 - 2R_0 r \cos l.
\]  

This is a second-order equation in \( r \), which has two possible solutions, \( r = r_+ \) and \( r = r_- \):

\[
r_{\pm} = \pm \sqrt{R^2 - R_0^2 \sin^2 l + R_0 \cos l}.
\]  

- If \( \cos l < 0 \) (in Quadrant II or III), one can show that there is one and only one positive solution, \( r_+ \), because \( R \) is always larger than \( R_0 \).

- In the other quadrants, there can be two positive solutions.

Negative values of \( r \) should be discarded because they have no physical meaning. If one obtains two positive solutions, one should observe toward the same Galactic longitude but at different Galactic latitudes to determine which solution is correct. By observing at a higher Galactic latitude, one wouldn’t be able to see a distant cloud lying in the Galactic plane.
2.4 Estimating the mass of our Galaxy

Assuming that most of the mass of our Galaxy is distributed in a spherical component around the center (in the so-called dark matter halo), one can calculate the mass \( M(< R) \) enclosed within a given radius \( R \). Indeed, for a spherically symmetric distribution, a theorem by Jeans tells us that the mass outside a radius \( R \) doesn’t affect the velocity of a point at that radius. Also, thanks to another theorem also due to Jeans, the matter at radius \( R \) moves in the same way as if all the mass were located in the center. Note that this is true only in the case of a spherically symmetric distribution! Then we can write (see also Appendix A)

\[
\frac{V^2}{R} = \frac{GM(< R)}{R^2}
\]

(2.10)

where \( G \) is the gravitational constant. We can derive \( M(< R) \):

\[
M(< R) = \frac{V^2R}{G}.
\]

(2.11)

→ Taking \( R = 10 \) kpc, \( V = V_\odot = 220 \) km/s, calculate the mass enclosed within 10 kpc. Express the mass in kg and in solar masses.

\[
G = 6.67 \times 10^{-11} \text{ N m}^2 \text{ kg}^{-2}
\]

1 M_\odot = 2 \times 10^{30} \text{ kg}

1 kpc = 10^3 \text{ pc}; 1 \text{ pc} = 3.086 \times 10^{16} \text{ m}
Chapter 3

Observing with Such A Lovely Small Antenna (SALSA)

3.1 SALSA-Onsala

The radio telescope is a modified television antenna with a diameter of 2.3 m. This provides an angular resolution of about 7° at the frequency of the HI line, 1420 MHz ($\lambda = 21$ cm). (Remember that the full moon has an angular diameter of about half a degree, or 30 minutes of arc. This corresponds to roughly the angular diameter of your thumb held at arm’s length. 7° corresponds roughly to the width of both hands held at arm’s length). The radio telescope is equipped with a newly designed receiver. The receiver has a bandwidth of 2.4 MHz and 256 frequency channels, so that each channel is 9.375 kHz wide.

3.2 Before the observations

Dear Observer,

The radio telescope is not a toy. It is a state-of-the-art sensitive instrument that should be handled with care. Before using it, it is important to prepare oneself carefully. You don’t want to waste precious time during your observing session. You don’t want to break the radio telescope.

So you should plan your observations. Don’t be afraid, just be prepared.

Before logging in onto the computer that controls the radio telescope, we trust that:

→ you will have read this entire document carefully;

→ you will have checked what part of the Galaxy is above the horizon in Onsala during your observing session, and have prepared a list of positions that you want to observe (see Appendix C).

Being able to detect a faint signal from outer space is a thrilling experience. When you see a signal, do remember where it comes from (do you remember what you read in Chapter 1? Please also read the rest of this chapter carefully).

With best wishes,

The Onsala team
3.3 How to observe with SALSA-Onsala

3.3.1 From a Unix machine

- Launch your favorite web browser and go to http://www.oso.chalmers.se/csm/lab/480.html. This allows you to see the radio telescope through a web camera placed in a nearby building.
- Open a terminal window.
- Connect to the computer in Onsala:
  ```
  ssh -X vale.oso.chalmers.se -l guest
  ```
Enter the password that has been given to you.
- Start the program qradio to control the radio telescope:
  ```
  qradio &
  ```
The qradio window appears (see Fig. 3.1).

![QRadio Interface](image)

**Figure 3.1:** Display of the control program of the radio telescope, qradio.

- Before starting the actual observations, some parameters need to be set up. First click on Control.
- In the **Receiver** box:
  - In the box **Mode**, select the button switched.
  - In the box **Switching**, the button **frequency** should be selected.
  - In the box **Frequency/Gain**, use the arrows to adjust the levels in both boxes labeled **dB** so that the levels in the box **Power** are both around 30%.
  - Now you have to select the direction of the sky that you want to observe.

In the box **Telescope**, you can see the current position of the radio telescope, displayed as the **azimuth** and the elevation values (the values actual are in degrees).

Select the coordinate system **Galactic**. In the two adjacent boxes to the right, enter the Galactic longitude ($l$) and latitude ($b$). To observe the Galactic plane, take $b = 0$ (just type 0 in the right box).

- Click on the button **Track** to move the telescope toward that direction. As soon as you have clicked on Track, the **commanded azimuth** and elevation values will appear and the radio telescope will start moving. Make sure that the elevation is above 20 degrees. If the elevation is too low, press **Stop** and select new coordinates.

- Look at the webcam image of the radio telescope to check that it is moving.

The actual values should converge toward the **commanded** values.

Once they agree, the telescope will track the position you have entered.

- Now you are ready to take a spectrum. In the lower right corner of the display, enter the integration time. One usually obtains a good spectrum after 30 seconds. Now, click on **Observe**.

  A filename appears in the left column (something like 00001c.fits). Click on **Spectrum** or on the filename in the box to the left to see your spectrum (see Fig. 3.2).

- To perform a new observation, click on **Control**. Click on **Stop**. Select a new position; then **Track** and **Observe**.

- When you are finished, click on **Reset** to park the radio telescope.

- If you want the spectra to be saved, you should go into **File**, and **Save all**, which saves all spectra in separate **FITS** files. It’s a good idea to place them into a new folder.

- When you are done, click on **File**, then **Exit**.

- To log out from the computer, type exit

### 3.3.2 From a Windows machine

Currently, you need to have a booting CD that will launch Knoppix, which will set up a Linux environment on your machine. Your harddisk won’t be touched.

To boot from the CD, one should press the key **F2** just after the computer has started.

Then you find yourself in a Linux environment. Follow the instructions in the previous section (Sect. 3.3.1).
3.3.3 kstars: A planetarium program to control the radio telescope

The program kstars is a planetarium software that can be used to control the radio telescope. It displays a map of the sky with a variety of celestial objects. It is possible to see the contours of Milky Way and, simply by clicking on a position, send the coordinates of the new position to qradio. For that, kstars must be connected to the radio telescope. You should have started qradio first. Then start kstars simply by typing

```
kstars &
```

The program is launched and a window opens.

- Go to Settings -> Geographic
- Click on Onsala, Sweden.
- Go to Devices -> Device manager -> Client
- Click on os2.3m
- Click on Connect.
- To do coordinate conversions:

\[ \text{The data files are in a special format called the Flexible Image Transport System (FITS). Each file contains two parts, a header that you can read, followed by a binary record of the data. The binary table can be interpreted and displayed with FITS-reading software.} \]
Figure 3.3: Display of kstars

Click on Tools -> Calculator -> Coordinate converter -> Equatorial/Galactic.
Chapter 4

After the observations – my first maps of the Milky Way

4.1 Software

The data can be analyzed using various computer programs. In the future, SalsaJ, which is the software for the Hands-On Universe, Europe project (EU-HOU\textsuperscript{1}) will be the standard software to perform the analysis.

You will also need a spreadsheet for calculations. If you have MS-office on your computer, use Excel for this part of the exercise. If not, the free office suite OpenOffice\textsuperscript{2} can be used.

4.2 Data processing

1. Look at the data.

You will probably use SalsaJ to look at your data. Learn how to display a spectrum (that is, read in the corresponding FITS file and display the values in a graphic window). Use the velocity scale on the $x$-axis. Do you see a beautiful spectrum? Congratulations!

2. Subtract a baseline to correct for the zero level.

This step is not absolutely necessary if you are interested only in measuring velocities (as in this exercise) and not intensities. In general, the zero level of the measured spectrum is not exactly zero. In addition, the “zero level” is sometimes not perfectly flat as a function of velocity or frequency. Therefore, one usually subtracts a baseline (a polynomial, usually of first-order) from the data to correct for this.

3. Measure the velocities.

We want to measure the velocities of the different components of each spectrum. At this time, it is judicious to open an Excel or OpenOffice table into which relevant numbers can be written. You will write in the first column of the table the Galactic longitude at which the spectrum was taken, and in the second one the velocity that you measure for each velocity component.

Inspect each spectrum, and measure the velocity of each component. This can be done using the cursor, or you may want to zoom to read the velocities more accurately. The velocities

1 http://www.euhou.net
2 http://www.openoffice.org
can be measured more accurately by fitting a Gaussian curve to a spectrum and taking the
central velocity of the fitted Gaussian.
If a spectrum has multiple components, write several lines in your Excel or OpenOffice table,
like:

<table>
<thead>
<tr>
<th>l</th>
<th>V</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>-48</td>
</tr>
<tr>
<td>50</td>
<td>12</td>
</tr>
<tr>
<td>50</td>
<td>25</td>
</tr>
<tr>
<td>70</td>
<td>-90</td>
</tr>
<tr>
<td>70</td>
<td>-22</td>
</tr>
<tr>
<td>70</td>
<td>2</td>
</tr>
</tbody>
</table>

This means that the spectrum at Galactic longitude \( l = 50 \) has three velocity components
(-48, 12 and 25 km/s), and the spectrum at longitude \( l = 70 \) also has three components.

### 4.3 Data analysis

#### 4.3.1 Rotation curve

Now we want to construct a rotation curve from the data points we have gathered. In Chapter 2,
we showed that if we observe gas in the tangential point, the distance from the center of the Milky
Way to the cloud can be found. The velocity of the cloud could also be calculated. In this section
we are only interested in the maximum velocity in each spectrum, which corresponds to hydrogen
at the tangential point.

To implement this analysis in a spreadsheet,

- write two columns with \( l \) and \( V_{r,\text{max}} \).
  
  We will now need to use the values \( R_0 \) and \( V_0 \) in the calculations. It is possible to write
  them directly into the formulae given in the previous section, but it is better to define them
  as constants in the current file.

- Write the values of \( R_0 \) and \( V_0 \) into two cells. Go to Insert ⇒ Names ⇒ Define. A box
  appears. Write \( R0 \) in the top field. Put the cursor in the lower field and then click in the cell
  containing the value of \( R_0 \). The name of the cell appears in the box. Click add, then repeat
  the process for \( V_0 \).
  
  You can now use \( R0 \) and \( V0 \) directly in the formulae.

- Now we want to calculate \( R \) and \( V \), using eq. [2.5]. Start a third column where \( R \) will be
  written. Click in the first cell and enter the formula

\[
= R0 \times \sin(A4 \times \pi / 180)
\]

where we have converted the degrees to radians and assumed that the first \( l \) is in cell A4.

Complete the row by marking the cell with the formula and drag in the lower right corner.

You have now calculated \( R \) for all the clouds at the tangent point.

- In the next column, write the formula

\[
= B4 \times V0 \times \sin(A4 \times \pi / 180)
\]

(eq. [2.5]), where we assumed that the velocity is in cell B4. Finish by completing the column
for all longitudes.

Now, you have the velocities and distances to the hydrogen gas cloud at several tangential
points. We want to plot them in a diagram.
• Begin by selecting the entire third and fourth column. Choose Insert ⇒ Chart and choose xy-chart without lines between the points. Then click Create and the chart appears on the spreadsheet.

• You can now adjust the size of the diagram; by right-clicking on it you can set labels on the axis and a title.

The plot should show an almost constant rotation curve.

<table>
<thead>
<tr>
<th>R</th>
<th>V</th>
<th>Z</th>
</tr>
</thead>
<tbody>
<tr>
<td>20</td>
<td>39.7</td>
<td>3.99</td>
</tr>
<tr>
<td>40</td>
<td>40.2</td>
<td>4.98</td>
</tr>
<tr>
<td>60</td>
<td>40.0</td>
<td>4.98</td>
</tr>
<tr>
<td>80</td>
<td>40.8</td>
<td>7.00</td>
</tr>
<tr>
<td>100</td>
<td>44.6</td>
<td>6.01</td>
</tr>
<tr>
<td>120</td>
<td>19.2</td>
<td>8.92</td>
</tr>
<tr>
<td>40</td>
<td>19.2</td>
<td>7.80</td>
</tr>
<tr>
<td>80</td>
<td>19.2</td>
<td>7.99</td>
</tr>
</tbody>
</table>

Rotation Curve

Figure 4.1: Example of a table and a rotation curve calculated using OpenOffice.

4.3.2 Map of the Milky Way

In this exercise we will use all velocities measured in the spectra. We want to construct a map of the hydrogen gas in the Galaxy. We follow the procedure outlined in section 2.3.

• Make sure that you have written velocities with corresponding Galactic longitudes in two separate columns.

• First, we want to calculate $R$, the distance to the center of the Galaxy (eq. 2.7). Enter the formula for $R$. You will have to use the functions
  
  - $\sin()$
  - $\pi()$

• Calculate $r$, the distance from us to the cloud. Look at equation 2.9. Since this is a second degree equation in $r$ you will get two solutions. Calculate $r_{\pm}$ and write them into two new columns. You will need the functions
- `POWER()` (that is, if you want cell A4², write `POWER(A4, 2)`)
- `SIN()` (remember to convert to radians)
- `COS()`
- `PI()`
- `SQRT()`

If you read section 2.3 carefully, you noticed that in the first and fourth quadrants the solution to this equation is not unique, and thus we may have two positive solutions. Additional measurements are needed to confirm which is the correct answer. Also, two negative solutions may occur, then you must discard this data point.

Now we are almost there! We have to calculate the xy-coordinates for the data points. The following formulae should be familiar to you:

\[
\begin{align*}
    x &= r \cos \theta \\
    y &= r \sin \theta
\end{align*}
\]  

(4.1)

To convert to xy-coordinates we need to think about how angles are defined in our coordinate system. Look at figure 4.2. The definition of \( l \) (Galactic) and \( \theta \) (polar) are clearly different. We find that \( \theta = 270° + l \), which can be rewritten as \( \theta = l - 90° \).

\[ y \]
\[ x \]
\[ \theta \]

\[ l \]

\[ r \]

\[ \theta \]

\[ l \]

\[ r \]

Figure 4.2: Illustration of polar \((r, \theta)\) versus Galactic \((r, l)\) coordinates.

- Now, calculate \( x \) and \( y \) by using equation (4.1). If you want the origin \((0, 0)\) to be in the Galactic center, add \( R_0 \) to the \( y \)-coordinate.
- Select the cells containing the \( xy \)-coordinates and insert a chart. You will now be able to see where the hydrogen is in the Galaxy, and the graph should show hints of spiral arms around the Galactic center.
Figure 4.3: Snapshot of the $x$-$y$ chart in OpenOffice. You can clearly see the spiral arms in the Galaxy. The blue circle represents the area of the Galaxy, which has diameter of 50 kpc.
Appendices
Appendix A

Rotation curves

A rotation curve shows the circular velocity as a function of radius.

A.1 Solid-body rotation

Think of a solid turntable, or a rotating CDrom. It rotates with a constant angular speed $\Omega = \frac{\pi}{\tau}$ = constant. The circular velocity is therefore proportional to the radius:

$$ V \propto R. $$

(A.1)

A.2 Keplerian rotation: the Solar system

![Graph showing rotational velocities of solar system planets](image)

**Figure A.1:** Rotational velocities of the planets of the Solar system. The line corresponds to Kepler’s law (eq. (A.3)) to which the planets show excellent agreement. The distance scale shown is in so-called *Astronomical Units* (AU) which is the distance between the Earth and the Sun. 1AU = 150·10^6 km.

In the Solar system, the planets have a negligible mass compared to the mass of the Sun. Therefore the center of mass of the Solar system is very close to the center of the Sun. The centrifugal
acceleration from the planet’s circular velocities counterbalances the gravitational acceleration:

\[ \frac{V^2}{R} = \frac{GM}{R^2} \]  \hspace{1cm} (A.2)

where \( M \) is the mass and \( G \) the gravitational constant. The rotation curve is said to be Keplerian, and the velocities decrease with increasing radius:

\[ V_{\text{Keplerian}}(R) = \sqrt{\frac{GM}{R}}. \]  \hspace{1cm} (A.3)

In Fig. A.1 we show the rotation curve of the Solar system.

### A.3 Differential rotation: a spiral galaxy

Similarly, the rotation curve of a galaxy \( V(R) \) shows the circular velocity as a function of galacto-centric radius. In contrast to the rotation curve of systems like the Solar system with a large central mass, most galaxies exhibit flat rotation curves, that is, \( V(R) \) doesn’t depend on \( R \) beyond a certain radius:

\[ V_{\text{Galaxy}}(R) = \text{constant} \]  \hspace{1cm} (A.4)

The angular velocity varies as \( \Omega \propto 1/R \). Matter near the center rotates with a larger angular speed than matter farther away.

At large radii, the velocities are significantly larger than in the Keplerian case, and this is an indication of the existence of additional matter at large radii. This is an indirect way to show the existence of dark matter in galaxies.

![Figure A.2: Sketch of the actual rotation curve of the Milky Way (solid blue line). The dotted red line is what we would expect from using Kepler’s law to calculate the rotation curve.](image-url)
Appendix B

Early history of 21 cm line observations

The story of the discovery of the 21 cm line of hydrogen is a fascinating one because it began during the Second World War, when international scientific contacts were disrupted and some scientists were struggling to carry out research.

In 1944, H.C. van de Hulst, a student in Holland, scientifically isolated because of the Nazi occupation of his country, presented a paper at a colloquium in Leiden in which he showed that the hyperfine levels of the ground state of the hydrogen atom produce a spectral line at a wavelength of about 21 cm, and that it could be detectable in the Galaxy. An article was published in a Dutch journal (Bakker and van de Hulst 1945).

After the war, efforts were made in several countries to design and construct equipment to detect the spectral line. It was first observed in the United States by Ewen and Purcell on 21 March 1951; in May the same year, it was observed by Muller and Oort (1951) in Holland. Both papers were published in the same issue of the journal Nature. Within two months Christiansen and Hindman (1952) in Australia had detected the line.

Ewen and Purcell used a small, pyramidal antenna.

The first systematic investigation of HI in the Galaxy was made in Holland by van de Hulst, Muller, and Oort (1954). The Dutch group used a reflector from a German radar receiver of the "Great Würzburg" type, 7.5 m in diameter. The beamwidth at λ21 cm was 1°.9 in the horizontal direction and 2°.7 in the vertical direction.

Christiansen and Hindman used a section of a paraboloidal reflector, with a beamwidth of about 2°.
Appendix C

The celestial sphere and astronomical coordinates

C.1 A place on Earth

The terrestrial equator is defined as the great circle halfway between the North and the South Poles. The "Prime Meridian" was defined in 1884 as the half circle passing through the poles and the old Royal Observatory in Greenwich, England (see Fig. C.1).

A location on the surface of the Earth is defined by three numbers: the longitude $\lambda$, the latitude $\phi$, and the height above sea level, $h$.

The longitude of a given point on Earth is measured westward from Prime Meridian to the intersection with the equator of the circle of longitude that passes through the point.

The latitude is the angle measured northward (positive) or southward (negative) along the circle of longitude from the equator to the point.

Onsala Space Observatory is located just a few meters above sea level, at the following longitude and latitude:

$$\lambda = 12^\circ 01'00''E \quad \phi = 57^\circ 25'00''N.$$ 

C.2 The celestial sphere

C.2.1 Equatorial coordinates

The celestial sphere is an imaginary sphere concentric with the Earth, on which astronomical objects are placed (see Fig. C.2). The celestial equator is the natural extension of Earth's equator. Because of the inclination of Earth's axis of rotation, the apparent annual path of the Sun on the celestial sphere (the ecliptic) doesn't coincide with the celestial equator; the ecliptic makes an angle of 23.5° with the celestial equator. The point where the Sun crosses the celestial equator going northward in spring is called the Vernal Equinox. On the equinox, the Sun lies in the Earth's equatorial plane, and the day and night are equally long. The solstices mark the dates when the Sun is farthest from the celestial equator and occur around June 21 and December 21.

→ Mark the north and south celestial poles, the celestial equator, the ecliptic, the solstices and the equinoxes on Fig. C.2.

Positions on the celestial sphere are defined by angles along great circles. By analogy with terrestrial longitude, right ascension (RA), $\alpha$, is the celestial longitude of an astronomical object,
Figure C.1: Illustration of the terrestrial system, with longitude ($\lambda$) and latitude ($\phi$). Great circles passing through the poles are circles of longitude. Circles parallel to the Earth equator are circles of latitude.

but it is measured eastward from the Vernal Equinox along the celestial equator. RA is expressed in hours and minutes of time, with 24 hours corresponding to 360°.

In analogy with terrestrial latitude, declination (DEC), $\delta$, is the angular distance of an object from the celestial equator. Right ascension and declination ($\alpha, \delta$) specify completely a position on the celestial sphere.

Imagine now that we find ourselves at location $P$ on Earth at a latitude $\phi$, and we want to observe the sky. An astronomical object of declination $\delta$ reaches a maximum altitude above the horizon, $h_{\text{max}}$, and a minimum altitude, $h_{\text{min}}$, given by

\[
\begin{align*}
    h_{\text{max}} &= 90^\circ - |\phi - \delta| \\
    h_{\text{min}} &= -90^\circ + |\phi + \delta|.
\end{align*}
\]  
(C.1)

$\rightarrow$ In Onsala, astronomical objects with $\delta > 33^\circ$ always remain above the horizon (they are circumpolar);

$\rightarrow$ those with $\delta < -33^\circ$ never rise above the horizon.

C.2.2 The Local Sidereal Time

The convention of measuring RA eastward was chosen because it makes the celestial sphere into the face of a clock. The hand of the clock is the local meridian, the north-south line passing through the observer’s zenith (the zenith is the upward prolongation of the observer’s plumb line – right overhead!).

When the Vernal Equinox is on the local meridian, the Local Sidereal Time (LST), or star time, is said to be 0 hours. On the Spring equinox (around March 21), this happens at noon (solar clock).

$\rightarrow$ To remember: On the Spring equinox (around March 21), LST= 0 h at noon (solar time).
Figure C.2: Illustration of the celestial coordinate system, with right ascension $\alpha$ and declination $\delta$. Earth is at the center. The plane of the ecliptic is inclined by 23.5° with respect to the celestial equator.

As time passes, astronomical objects on the local meridian will have a larger RA. At any moment and any location on Earth, the LST equals the RA of astronomical objects on the local meridian.

The celestial clock moves ahead of the solar clock every day. This is because Earth rotates both around its own axis, and also around the Sun, as illustrated in Fig. C.3. After 24 hours of solar time, a given location on Earth finds itself at the same solar time (which is with respect to the Sun). For instance, every day the Sun reaches its highest elevation at the same solar time. But relative to the stars, it finds itself on the same position a little bit earlier (corresponding to only one rotation around its axis). 24 hours of LST time pass in only 23 hours 56 minutes 05 seconds of solar time. A certain LST time occurs about 4 minutes earlier than it had the day before.

We have said that on the Spring equinox, around March 21, the LST is 0 h at 12 h solar time (noon). The next day at noon, the LST will be 0 h 3 min and 56 sec; inversely, 0 h of LST time correspond to 11 h 46 m 05 s solar time. With each passing month, a given LST time occurs 2 hours earlier.

C.2.3 How can I know whether my source is up?

Let’s imagine that we want to observe in a certain direction in the Galactic plane (a certain Galactic longitude $l$, and a Galactic latitude $b = 0$) at a certain time.

First of all, we need to convert the Galactic coordinates into celestial equatorial coordinates: RA and DEC. For this, we may use the table to find $\alpha$ and $\delta$.

As we have shown above, some sources will never rise above the horizon in Onsala (the ones with $\delta < -33^\circ$).

It is best to study examples to learn how to find out when a source is visible.

Example 1. I have been allocated time to observe with the radio telescope on May 5, starting at
Figure C.3: The Local Sideral Time is the time relative to the stars, whereas the solar time is relative to the Sun. 24 hours of LST time pass in only 23 hours 56 minutes 05 seconds of solar time, because Earth, having moved on its orbit around the Sun, finds itself the next day at the same position relative the stars a bit earlier than at the same position relative to the Sun. In one year (365 days), Earth has moved $360^\circ$ around the Sun and lost one turn (24 hours) relative to the stars. So the difference in one day is $24 \text{ hours} / 365 = 3.56\text{h}$.

15 hours local time in Onsala. This corresponds to 13 hours solar time. What is the corresponding LST time? What part of the Galaxy can I observe?

On March 21, LST=0 h at noon.

⇒ LST= 1 h at 13 h.

May 5 occurs 1.5 months after March 21. The LST time shifts by 24 hours per year, or 2 hours per month. So, 1.5 months after March 21, LST=1 h will occur at $t = 13 - (1.5 \times 2) = 10 \text{ h}$ and at 13 h, LST= 4 h. This means that sources will $\alpha = 4 \text{ h}$ will cross their meridian (be highest above the horizon) at that time.

Looking at the table, we see that $l \simeq 150^\circ$ corresponds to $\alpha \simeq 4 \text{ h}$. Since that Galactic longitude doesn’t reach a very high elevation in Onsala, it is a good idea to start by observing it because it will be setting quickly.

Example 2. Today is Christmas Eve, and I have been offered a small optical telescope. I would like to use it to observe the beautiful Whirlpool galaxy M 51. Is it possible?

The coordinates of M 51 are $\alpha \simeq 13 \text{ h } 30\text{m}, \delta \simeq +47^\circ$. This means that M 51 will be at its highest elevation above the horizon at LST=13 h 30.

LST= 0 h at noon = 12 h around March 21.
LST= 0 h at $12 - (2 \times 9) = -6 \text{ h}$ (or 24 - 6 = 18 h) around Dec. 21 (9 months after March 21, since the LST time shifts ahead by 2 hours every month).
LST=13 h 30 at $18+13 \text{ h} = 30 - 7 \text{ h} 30$.

M 51 will be highest up on the sky in the morning at 7 h30, and it will be rising during the second part of the night.
<table>
<thead>
<tr>
<th>$l$</th>
<th>$\alpha(J2000)$</th>
<th>$\delta(J2000)$</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>17h45</td>
<td>$-28:56$</td>
</tr>
<tr>
<td>20</td>
<td>18h27</td>
<td>$-11:29$</td>
</tr>
<tr>
<td>40</td>
<td>19h04</td>
<td>06:17</td>
</tr>
<tr>
<td>60</td>
<td>19h43</td>
<td>23:53</td>
</tr>
<tr>
<td>80</td>
<td>20h35</td>
<td>40:39</td>
</tr>
<tr>
<td>100</td>
<td>22h00</td>
<td>55:02</td>
</tr>
<tr>
<td>120</td>
<td>00h25</td>
<td>62:43</td>
</tr>
<tr>
<td>140</td>
<td>03h07</td>
<td>58:17</td>
</tr>
<tr>
<td>160</td>
<td>04h46</td>
<td>45:14</td>
</tr>
<tr>
<td>180</td>
<td>05h45</td>
<td>28:56</td>
</tr>
<tr>
<td>200</td>
<td>06h27</td>
<td>11:29</td>
</tr>
<tr>
<td>220</td>
<td>07h04</td>
<td>$-06:17$</td>
</tr>
<tr>
<td>240</td>
<td>07h43</td>
<td>$-23:53$</td>
</tr>
<tr>
<td>260</td>
<td>08h35</td>
<td>$-40:39$</td>
</tr>
<tr>
<td>280</td>
<td>10h00</td>
<td>$-55:02$</td>
</tr>
<tr>
<td>300</td>
<td>12h25</td>
<td>$-62:43$</td>
</tr>
<tr>
<td>320</td>
<td>15h07</td>
<td>$-58:17$</td>
</tr>
<tr>
<td>340</td>
<td>16h46</td>
<td>$-45:14$</td>
</tr>
</tbody>
</table>

Table C.1: Conversion from Galactic coordinates to right ascension and declination for different values of $l$, with $b = 0$. The Galactic longitudes in bold face (and green) are circumpolar at the latitude of Ossia ($\delta > 33^\circ$). The Galactic longitudes in red are always below the horizon at the latitude of Ossia.
Appendix D

Useful links

- **http://www.euhou.net/**
  The official homepage of the Hand-On Universe, Europe project (EU-HOU).

- **http://www.oso.chalmers.se/**
  Onsala Space Observatory.

- **http://www.openoffice.org/**
  The Office suite OpenOffice.

- **http://hea-www.harvard.edu/3D/ds9/**
  A software to analyze astronomical data.

- **http://www.astronomynotes.com/**
  A general introduction to astronomy. In chapter 14, neutral hydrogen in the Milky Way is described.

- **http://nedwww.ipac.caltech.edu/**
  NASA/IPAC Extragalactic Database (NED).

- **http://antwrp.gsfc.nasa.gov/apod/astropix.html**
  The Astronomy Picture of the Day. It contains several pictures of the Milky Way, among many other beautiful astronomical pictures.

- **http://web.haystack.mit.edu/uresi/tutorial.html**
  A tutorial on radio astronomy, and information on the early days of radio astronomy.
Bibliography


[5] Hulst, H.C. van de, Muller, C.A., Oort, J.H., 1954, B.A.N. 12, 117 (No. 452), The spiral structure of the outer part of the galactic system derived from the hydrogen emission at 21-cm wavelength


Acknowledgements

Special thanks to Roy Booth, Rune Byström, Magne Hagström and Michael Olberg without whom SALSA-Onsala wouldn’t exist. We are very grateful to Christer Andersson, John H. Black and Åke Hjalmarson for very useful comments on the manuscript.